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Logging In 
Click on Contact Us tab.  Enter your Heartfelt email address and web password.  This will activate the 
administrative options on each page. 

Setting Up Other Administrative Users 
Administrative users need to be set up by Igniting Business.  To create a support ticket to ask that a new 
user be created, go to http://apps.ignitingbusiness.com/support-requests.   

MANAGING THE MAIN SITE 

Editing the Home Page 
 

Top Slider Images 

The optimum image size is 480 x 315 pixels, but it doesn't have to be exact. The image handler 
automatically adjusts the image to fit. A ratio of 2x3 is technically what its dimensions support. To edit 
this slider, login as an administrator, then navigate to the home page and hover the mouse over the 
“Home” menu item.  Click “Edit Homepage Slideshow.” 
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1.  In the Home Page Slideshow 
editing menu, click “Manage 
Images” in the row for the Home 
Page Slideshow. The trash can icon 
under the delete column will delete 
the whole slideshow. 

2.  Once the Image Manager page 
appears, you can now click “Add 
Files” or simply drag new images 
to the grey box at the top.  

3.  When the images you want are 
listed, click “Start Upload.” 

4. Images can be deleted by clicking 
the box on the far left side of the 
row with the image to be deleted 
and then clicking the Delete button. 

5. Image(s) can be unpublished, and 
the sequence in which the images 
will appear can be re-ordered using 
the last two columns on the right 
for each image. 

Blog Highlights  

The blog highlights on the home page appear automatically and are not user editable. 

Featured Products Carousel 

The carousel images of “featured products” can be changed by navigating from Shop Online>Manage 
Store>Extensions>Modifications>Modules.   Click the blue pencil edit icon, and the Products section will 
show which items are already featured. To add a new item, type the title of the product in the Products 
field (the field that looks like the title box).  As you start typing, the search will create a drop-down with 
matching products.  Select the product you want to add. Click Save to save your changes. 

Note that the home page carousel only supports four featured items, so best practice is to swap out of 
replace the existing items that are there. You can do this by clicking the minus/delete button next to the 
product name in the list of currently featured products.  The number of items can be adjusted, but it may 
require additional coding to make the design look right. 

Heartfelt Alpaca Creations Text 

To edit the “Heartfelt Alpaca Creations” text at the bottom of the page, scroll to the bottom left corner of 

the text block and click the Edit button - .  This will open a window with various editing 
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functions. For details about the options for editing text and adding or deleting images, see those sections 
of this manual. 

Editing the About Heartfelt, Wholesale, and FAQ Pages 
Login to the website and open the page you want to edit. Scroll to the bottom of the text box that you 

want to edit and find the edit button in the lower left corner.  It looks like this .  Click the edit 
button.  This will open a window with various editing functions. For details about the options for editing 
text and adding or deleting images, see those sections of this manual. 

Editing Text 

The text editor opens once you click the edit button   at the bottom left corner of the text box you 
want to edit.  Many of the editor functions are similar to those in Microsoft Word, although there are 
some significant differences. The numbered buttons in Figure 1 correspond to the numbered list of 
explanations below the figure.  In addition, the text editior has a row of rectangular buttons below the text 
window.  These have been auto-formatted with the proper content and should not be needed unless 
special circumstances arise. 

1. When you are satisified with your changes, click Save to save the page. 

2. If you decide not to save your changes, do not just close the window.  Instead, click the Cancel button 
so that the changes are discarded properly. 

3. The Versions button (Figure 2) shows the various versions of the page that are stored in the system 
and allows you to go back to an earlier version. 

1 2 3 
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Figure 1. Text Editor. 
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4. The Content tab opens by default and allows you to edit the 
content of the page.  This is the screen shown in Figure 1 above. 

5. The Publishing tab (Figure 3) allows you to set the date when your page will go live and to restrict 
access to the page to certain groups of users. 

6. The Language tab defaults to “All” and probably shouldn’t be changed. 

7. The Metadata tab allows you to associate meta tags and keywords with the page or text box you are 
editing (Figure 4).  

8. The title of the page is the heading that will display at the top of the page or text box. 

9. The formatting buttons for bold, italic, strikethrough, numbered, and bulleted text function pretty 
much as they do in a normal word processor like Microsoft 
Word. 

10. The button with the quotation marks is for block quotes.  To 
use this, select a block of text, then click the block quote 
button.  The text will be indented, bolded, and set off from 
the rest of the text.  

The three buttons to the right of the block quote button set the 
text to right, centered, or left justification as they would in a 
word processing application. 

11. The two buttons with the icons that look like an intact chain 
and a broken chain are for linking text to another place such 
as another web page, an email address, or a document for 
downloading (Figure 5).  To delete a link, just highlight the 

Figure 2. Versions History. 

Figure 3. Publishing Options. 

Figure 5. Links Dialogue Box. 

Figure 4. Meta Tab 
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text that has a link and click the broken chain button. To add a link, highlight the text that you want to 
link to and then click the intact chain. You should type or paste the URL for a web page into the URL 
box for links to web pages. For links to email, click the envelope icon on the right side of the URL 
box to open the email dialogue box and fill in the email address.  The Text box on the main Links 
dialogue box will automatically have the text that you highlighted before you clicked the link button. 

To link to a document for downloading, you can use the window with the folders to navigate to the 
document.  This means that you have to have uploaded the document before you can link to it.  The 
next section of this manual describes the process for uploading a document. 

12. Moving right along the top row of icons, the next three have to do with inserting images, “read more,” 
and page breaks into your text (Figure 6).  To insert an image, place the cursor at the location where 
the image should be inserted.   

 
Click the icon for inserting an image to open the 
Image Manager dialogue box (Figure 7). The 
Alignment options determine where the image will 
display relative to the text.  You can use the 
Dimensions to size the image, but it may be easier to 
resize it by dragging the “handles” of the image after it has been place in the text.  Navigate to the 
folder and click on the file that you want to insert. The preview column in the upper right corner 
shows you how your image will appear relative to text based upon your selections. 

 Click the Insert button in the bottom right corner to insert the image.  If you change your mind, be 
sure to click Cancel rather than closing the window so that change are properly discarded. 

To insert “read more” or a page break, place the cursor in the text where you want the insertion and 
then click the relevant icon. 

13. The last two icons in the top row are for check the spelling of your text and displaying the editor 
window as a full screen. Clicking these icons toggle the features on an off. 

14. The drop-down box on the left end of the bottom row of editor icons is roughly comparable to the 
“styles” settings in word processing programs–it applies pre-programmed formatting to selected text.  
These options control font size and Search Engine Optimization codes.  The default is Paragraph, and 
this should be used for all basic text.  Headings are used to emphasize content sections. 

15. The next two buttons go with the formatting buttons in the row above them–the “U” underlines 
selected text, and the next button sets texts to full (both left and right) justification. 

Figure 6. Insertion Icons 

Figure 7. Image Manager 
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16. The four buttons over number 16 are cut, copy, paste, and paste as plain text. These function largely 
as they do in word processors.  Note, however, that when copying and pasting, the paste button 
should be used rather than right clicking or using Control-V.  Clicking the paste button will launch a 
dialog box in which you can paste your content.  Once you confirm your content, the dialogue box 
will clean it of any conflicting code and formatting in order to match your website’s formatting. 

If you are copying and pasting from Word, be sure to click the down arrow to the right of the paste 
button to select “Paste from Word.”  Word has a significant amount of invisible code that often 
causes potential problems when pasting to the online environment. 

17. The next four buttons are to remove formatting, insert special characters, indent, and outdent selected 
text. 

18. The circular arrow buttons are to undo or re-do your most recent action.  

19. The last two buttons in this row take you to the help files and open the source code editor. 

Organizing Text 
 In addition to the text editing controls above the text window, there are seven blue buttons below the text 
window (Figure 8), most of which have to do with organizing the text.   

1.  Gallery–Our consultants recommend against using this feature. 

2. Tabs are displayed horizontally across the page (Figure 9).    

Begin by navigating to the tab section you would like to modify, and select the edit button to open the 
Text Editor. Scroll the bottom of the content within the text window. Click Enter to allow some 
spacing after the previous tab. 

Click the Insert Tabs button, and the text should appear as shown at right.  

Where “Tab Title #” is displayed, highlight that portion of the text (do not highlight 
the brackets or the word “tab”), and enter the title you wish to be displayed on the 
tab.    

Figure 9. Sample tabs 

Figure 8. Text Editors controls below the text window. 
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Where “Your text…” is displayed, highlight, and enter the actual text you wish to have displayed 
on opening the tab.  

To customize the color of each tab, insert  “|colorname” after the Tab title. Color options include blue, 
green, orange, red, and grey. The color name must be all lowercase as in the example below: 

{tab Promote Products in SharedDeal|orange} 

Be sure to save your changes at the bottom of the page. 

3. Sliders are displayed vertically down the page (Figure 10). 

 

Begin by navigating to the slider section you would like to modify, and select 
the edit button to open the Text Editor. Scroll the bottom of the content within 
the text window. Click Enter to allow some spacing after the previous slider. 

Click the Insert Slider button, and the text should appear as shown at right.  

Where “Slider Title #” is displayed, highlight that portion of the text (do not highlight the brackets or 
the word “slider”), and enter the title you wish to be displayed on the slider.    

Where “Your text…” is displayed, highlight, and enter the actual text you wish to have displayed on 
opening the slider.  

To customize the color of each tab, insert  “|colorname” after the Slider title. Color options include 
blue, green, orange, red, and grey. The color name must be all lowercase as in the example below: 

{tab Promote Products in SharedDeal|orange} 

Be sure to save your changes at the bottom of the page. 

4. Article–Our consultants recommend against using this feature. 

5. Image–Our consultants recommend against using this feature. 

6. Page Break–Our consultants recommend against using this feature. 

7. Read More–Our consultants recommend against using this feature. 

Figure 10. Sliders are displayed vertically down the page.
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Uploading Images 
Begin by logging in as an administrator. Navigate to the page where you want to insert an image, and 
place the cursor at the location where the image should be inserted.  Navigate to the article that you would 
like to edit, and click the icon for inserting an image to open the Image Manager (Figures 6 and 7). 

Once the Image Manager dialogue box appears (Figure 11), click the upload button (#1).  

Drag and drop your image(s) to the Upload box that appears or select Browse, and click Upload when you 
are ready. The images will upload, and the system will close the upload dialogue box. 

You will now see your uploaded images in the file explorer.  Double click your image name to select it 
for inserting. 

Once your formatting is completed using the Alignment, Margin, and Border settings (#2), click Insert 
(#3). 

Uploading Documents for User Downloads 
This process is almost the same as the process for uploading images.  The biggest difference is that 
instead of just clicking the Insert Image icon, you will also use the Insert Link icon (Figure 1) to get to the 
Links dialogue box (Figure 5).  Begin by clicking the Insert Image icon. Follow the steps for uploading 
images to navigate to the file you want to upload, upload the file, and then click Cancel to leave the Image 
Manager dialogue box.   

Next select the text that you want the user to click to get to the file that you uploaded.  Then click the 
Link icon.  At the top of the Links dialogue box, the first icon to the right of the URL field is the Browse 
icon.  Click this, select the file you want users to see, and then click Insert in the lower right corner of the 
dialogue box.  

Figure 11. Image Manager 
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Managing the Blog 
Begin by logging in as an administrator and navigating to 
the Blog page.  

Create a New Post 

Click Edit/New Article Icon from the blog toolbar.   

 

1. The top row of icons allow you to move around within the Blog Manager. 

Figure 12. Blog Edit/New Article icon. 

Figure 13. Blog Editor. Note that this is a very long window that is 
displayed here in two parts. 
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Home–This icon takes you out of the Blog Editor and back to the main Blog page. 

Overview–This icon takes you to summary statistics for your blog (Figure 14). 

List–This third icon takes you to a listing of all the blog posts (Figure 15). 

Folder–The fourth icon allows you to manage the blog categories you have created or to create new 
categories. 

Tags–Similarly, the last of the icons on the left side of the bar allows you to manage any tags you 
have created. 

The first icon on the right side of the bar opens the Blog Editor so that you can write a new post. 

Thumbtack–This icon allows you to make a quick update to the Blog. 

Gear–The last icon shows who is logged in and allows you to log out of the Blog. 

2. The first icon allows you to preview what your post will look like on the blog.   

The second icon allows you to save the post as a draft if you haven’t finished working on it yet.  

The third button, Media Manager, is not in use on our site. 

3. Share is not in use on our site. 

Cancel–Be sure to use this if you decide to get rid of what you’ve done so that the system deletes the 
changes or new content appropriately. 

Apply–This applies any changes you’ve made and allows you to continue to work. 

Figure 14. Blog Overview 

Figure 15. Blog Post List 

Figure 16. Blog Category Manager 
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Publish Now–When you finish your post, select Publish Now, and your blog will be posted on the 
date you set as the Publication Date.  Or click Save as Draft and come back to edit the blog later. 

4. Categories–This drop-down displays the categories created with the button in the top (black) menu 
bar (see item #1 above).  It’s a good idea to assign a category to each post to make them easier to find 
for the users. 

5. The title you enter here will appear as the heading for the post. 

6. The system will create a permalink, which is a URL for this specific blog post.  You can manually 
write this link if you like, but you must do so prior to publishing the blog. 

7. Use the drop-down arrow for this box to set the group(s) of viewers who will be able to see this post. 

8. Older Posts–Clicking this button opens a search box so that you can search for an older post and 
insert a link to it in the current post you are creating. 

9. Use the Insert Media button or the standard image manager which is used for the rest of the site to 
add images to your post.  We recommend using the Media Manager so that the blog files are separate 
from the static pages on the rest of the website. 

10. Embed Video–This button allows you to insert links to external videos (like YouTube) into your post. 
With YouTube, be sure to use the URL that links to the video itself rather than to a YouTube channel.  
Be careful not to change the code snippet that is created for the embedded video. 

11. Published – This box simply shows whether or not the post has been published or not. 

12. Refer to the Editing Text section above for explanations of the text editing icons. 

13. Refer to the Organizing Text section above for explanations of the Gallery, Insert Tabs, Insert Sliders, 
Article, and Read More buttons. 

14. Congratulations and Thank You–Our consultants recommend against using this feature. 

15. Use the Publishing Options to specify any special details such as post scheduling, publishing under 
another authors name if you are publishing on someone else’s behalf. Note that the date of the post 
that displays on the blog is the Creation Date, so you will probably want to set this to the same date as 
the Publishing Date. 

16. You can enter a META Description if you want a certain sentence or two to be displayed on Google 
searches underneath the blog post title.  Otherwise Google will use its best judgment based upon the 
content of the article.  Keywords and Robots should be left blank as these are auto-generated. 

Editing an Existing Post 

To edit a post, go to the listing of posts (see item 1 under Creating a New Blog Post).  Find the post that 
you want to edit, and click the Edit button at the bottom of the entry for that post (see Figure 15)  

When you are finished editing, click Update Post, or if you want to discard your changes, click Cancel to 
be sure that the changes are properly discarded in the system. 
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MANAGING THE STORE 

Logging In 
Click on Contact Us tab.  Enter your Heartfelt email address and web password.  This will activate the 
administrative options on each page.   

Navigate to the Shop Online tab and select Manage Store. 

Categories 
Before any products are added, it is important to create a few categories. It is not required to assign 
products to categories, but it is good practice to do so. To add a category, click on Catalog and then 
Categories (Figure 17 #1). At the top-right of the page, click + sign (Figure 17 #2) to insert a new 
category.  

 Editing an Existing Category 

Click the pencil to the right side of the category row to open the tabs for the category you want to edit 
(Figure 17).  These are described below in the section on creating a new category. 

  

Figure 17: Categories 

1 

2



Return to Top 
 

13 | P a g e  

Creating a New Category 

General tab (Figure 18)–Enter the Category Name.  The Alias field is only for search engines and will not 
be seen by any customers. Type the category name with all lowercase letters, and replace spaces with 
dashes. For example, the proper alias for “Photo Prints” is “photo-prints.”  The Description is text that 
will be visible on the Categories page of the store to help customers know more about the products 
included in each category. 

Data tab (Figure 19 below)– 

Parent – If you are creating a subcategory, make sure to enter the parent category here. If there is no 
parent category, choose None. 

Stores – Make sure Default is checked. 

Image – Click the cart icon and then the pencil icon to choose an image to represent this category. You 
can use images that are already there, or upload new images as described in the Uploading Images section 
above. 

Figure 18. Add Categories: General Tab. 



Return to Top 
 

14 | P a g e  

 

Status – This toggles between Enabled and Disabled and determines whether or not the category will be 
displayed in the store. 

After you have filled out the General and Data tab information, click the Save button (circled at the top of 
Figure 19).  

 

Products 
Once the categories are in place, you can start entering products. To add a product, click Catalog, then 
Products (Figure 20 #1), then the + sign (Figure 20 #2) to add a new product.  To edit an existing product, 
click the pencil on the right side of the row for the product to be edited. 

 

 

Figure 19: Add Category: Data Tab 
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General Tab (Figure 21) 

Product Name – Enter the name the 
customer will see. 

Alias - this is only for search engines, and 
will not be seen by any customers. Enter the 
product name with all lowercase letters, and 
replace spaces with dashes. For example, 
the proper alias for “Love Your Mother 
Wall Hanging” is “love-your-mother-wall-
hanging.”  

Description – This will be visible on the 
product page to help customers know more 
about the product. 

Data Tab (Figure 22) 

Image - Click the cart icon and then the pencil icon to choose an image for the product. You can use 
images that are already there, or upload new images as described in the Uploading Images section above. 
The image that was added in the Data tab will be the main product image 

Model – If there is no model number for a product, enter in a code that uniquely identifies the product 
(i.e. BK3, 4H7R, MACH59) 

Price – Enter the price. Do not enter a dollar sign! Examples would be 35.99, 45.00, 3.50. 

Figure 20. Product List 
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Figure 21. Insert Products: General Tab 
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Tax Class – Choose Taxable Goods. 

Quantity – Enter the number of a product you have to sell. If there is no limit, enter 999999. 

Minimum Quantity – Here you can force a customer to buy a certain amount of a product. By default 
this is set to 1. 

Subtract Stock – If the quantity of a product is not important, you can set this product to never subtract 
stock by choosing No. Otherwise, select Yes. 

Figure 21. Add Products: Data Tab 
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Requires Shipping – Set to Yes for all Heartfelt products. 

Date Available – If you want to have a product available at a later date, you can choose the day. The 
default is the day the product is created. 

Status – This toggles whether or not the product will be displayed in the store. 

Links Tab 

Categories – here you can assign a product to one or more categories 

Store – make sure Default is checked 

Related Products – here you can choose other products to be associated with this product. They will 
appear under the related products tab on the product page. 

Attribute Tab 

This is a special part of a product and is discussed in its own section below. 

Option Tab 

This is a special part of a product and is discussed in its own section below. 

Image Tab 

Use this tab if you have additional images for the product. The image that was added in the Data tab will 
be the main product image. 

Saving Your Changes/Additions 

After you have filled out ll the information, click the Save & Close (Figure 22 #1). If you are adding a 
lot of products, you can click Save & New (Figure 22, #2) to save your changes and open a new Add 
Product form.  

Attributes 
Attributes are similar to additional features of a product. This is most often utilized when highlighting the 
specifications of a particular product. For example, if you wanted to emphasis the size of a certain poster 
or maybe the design of a photo print. 
In order to create an attribute, first you need to create an 
attribute group. To do this, click Catalog. From the 
Attributes submenu you should see Attribute Groups. Click 
the Insert button at the top-right of the page. The only piece 

1 2

Figure 22. Add Products: Saving Changes/Additions 
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of information that you need to enter is the Attribute Group Name. Click Save when finished. 

Once there is an attribute group, you can start creating individual attributes. From the Attributes submenu 
you should see Attributes. Click the Insert button at the top-right of the page. Enter an Attribute Name 
and choose an Attribute Group. Click Save when finished. 

Options 
This is how you can have customers choose colors, sizes, or anything else when it comes to products. 
Before you can assign an option to a product, you first need to create that option. Click Catalog and 
choose Options. Click the Insert button in the top-right of the page. Here what you need to fill out: 

Option Name – enter a name for the option 

Type – below are the most common option types 

Select – Dropdown of two or more choices 

Radio – same as select, but with radio buttons 

Checkbox – customers can select more than one option 

Text – a box where customers can type 

Option Value Name – when 
you click Add Option Value, 
you can enter a choice for the 
user. If you continue to click 
Add Option Value, you can 
keep adding different options. 

Once you are finished, click 
Save. 

Now that the option has been 
created, you can assign it to a product. When you are creating or editing a product, find the Options tab. 
Here are the steps to assigning an option: 

Type the name of the option in the box on the left-hand side. Select your option. 

Click the Add Option Value button to add all the option values that you want for the product 

You can choose the quantity and stock type of the individual option values. 

The price category is how much price you want to add or subtract to the original value of the product 

Click Save when finished 
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Customer Reviews 
To manage customer reviews, click Catalog 
and select Reviews. Here you will see all the 
reviews that have been submitted by 
customers. Reviews will need your approval, 
so it is important to enable reviews if you think 
they should be displayed. To edit a review, 
click the Edit link associated with a review. If 
you need to add a review over the phone, you 
can click the Insert button. Enter in the author, 

text, and the rating. Finally, you can also delete reviews by selecting one or more customer reviews and 
clicking Delete. 

Orders and Invoices 
Click Sales and then Orders. You will see a 
list of sales. You can easily get a printable 
invoice by selecting an order and clicking 
the Print Invoice button.  

 

 

 

 


